Introduction

Microsoft Draw allows you to produce your own drawings (or edit existing ones) and is available to you in all the Microsoft Office programs (except Access - though you can copy a drawing created in one of the other applications onto an Access form). You cannot load Microsoft Draw independently; it is provided as part of the other software packages.
This document is designed to cover the features available to you when you use Draw in any of the Microsoft Office programs. Slight variations exist between the products (for example, Word has text wrapping effects, while PowerPoint provides Action Buttons). These variations are not covered here.

Note that drawings and pictures are fundamentally different. Drawings are composed of lines and areas, whereas a picture is a fine grid of coloured dots (a bitmap). If you paste a drawing into a painting program, its component units (the lines etc) are lost - they become a series of individual dots. To create a picture you need to use a painting package such as Microsoft Paint (see A Guide to Microsoft Paint for details).

1. Start by loading up the required Microsoft Office application – here use Microsoft PowerPoint
2. [Maximize] the window to make full use of the screen
3. Click on the [Layout] button in the Slides group on the Home tab of the Ribbon and select Blank

Activating the Drawing Tools

To activate the Drawing Tools you simply have to use one. When you do, the Drawing Tools Format tab is added to the Ribbon.

1. Move to the Insert tab and, in the Illustrations group, click on [Shapes] (in PowerPoint this button is also on the Home tab) – a drop-down list appears, as shown on the right

As you can see, there are a host of different shapes to choose from, split into several groups. The first group, called Recently Used Shapes, contains the basic shapes – a text box, line, arrowed line, rectangle/square and oval/circle. You will be trying these out first. There are further basic shapes in this group (eg a triangle, connector, block arrow, star etc) which will be dealt with later. Further groups (Lines, Rectangles, Basic Shapes etc) give you access to even more sophisticated drawing tools.

Let’s start with a simple line:

2. Click on the second of the six buttons - [Line]
3. Move the mouse cursor to where you would like to draw a line on the slide then hold down the left mouse button and move the mouse
4. As the mouse is moved an elastic line appears, starting at the position where you first held down the mouse button and ending at the current position of the mouse cursor
5. Position the mouse cursor where you want the line to end then release the mouse button - a line with small circles (handles) at each end appears (you will learn about handles later)

The same principal works with the next three tools on the Drawing toolbar:

6. Click on the (third) [Arrow] button
7. Repeat steps 3 to 5 - the arrow head appears at the end of the line (step 5)
8. Click on the (fourth) [Rectangle] button
9. Repeat steps 3 to 5 - this time an elastic rectangle appears (it’s filled with blue in PowerPoint but has no fill colour in the other Office programs)
10. Finally click on the (fifth) [Oval] button and repeat steps 3 to 5

If you want to draw a square or circle, hold down the <Shift> key as you drag out the shape:

11. Click on either the [Rectangle] or [Oval] button, hold down <Shift> and draw a square or circle
The first button in this group is for text. A text box can be completely independent or can be associated with an area object such as a rectangle or oval.

12. Click on the (first) [Text Box] button then point the mouse cursor to where you want the text to appear and click the mouse button

A box appears with a flashing cursor in it indicating the typing position (in Excel/PowerPoint it's a small box which grows as you type; in Word you get a fixed 1 inch square). You can create a bigger box by dragging out a rectangle. In Word only, a Text Box Tools tab is added to the Ribbon.

13. Type some words into the text box - note that you can press <Enter> for a new paragraph

14. Click away from the text box when you have finished typing

Note: The text can be rotated through 90º. In Word, this is done using the [Text Direction] button on the Text Box Tools tab. In PowerPoint, the [Text Direction] button is in the Paragraph group. PowerPoint also lets you freely rotate text to any angle using the green rotation handle which appears when a text box is selected.

To add some text to an object (eg a rectangle or oval):

15. Click on the [Text Box] button then on the rectangle you drew previously

16. Type in your text – this wraps around within the object (you’ll see later how to enlarge it, if necessary)

17. Set the text orientation, if required, then click away when you've finished

Editing Drawing Objects

Once you've drawn an object you can change its size, shape and colour. It's generally easier to make such changes after you've drawn the object but you can set up colours, line styles etc before you begin to draw it, if you prefer. You can also move it or delete an object.

You will probably have noticed the little circles which surround an object when you draw it. Lines have a small circle at each end; rectangles, ovals and text boxes have circles at each corner and mid-way along each side. These circles are known as handles and are the key to editing. The green circle on the top of some objects is used for rotation, as you will see later.

Changing the Size/Shape of an Object

To change the size or shape of an object:

1. Click once on the object to select it (try an oval first) - the handles should appear
2. Move the mouse pointer over a corner handle (the opposite corner will become the fixed position) and note how the cursor becomes a double-headed arrow
3. Hold down the mouse button (the cursor becomes a plain cross) and move the mouse around
4. Release the mouse button when the shape is as required

By using a corner handle, you can change the oval both horizontally and vertically. If you use a side handle, you can only resize in one direction.

5. Repeat steps 2 to 4 using a side handle

Next try resizing a line/arrow. Selecting a two-dimensional shape isn't quite so easy - you have to place the mouse cursor in exactly the right place before you click the mouse button. You can tell when it's correct because a four-headed cross is added to the pointer.

Tip: You can also use the <Tab> key to move between and select objects.

6. Move the mouse cursor over a line/arrow until the cross appears (ie anywhere on the line)
7. Click on the mouse button to select the line/arrow
8. Point to an end handle, hold down the mouse button and drag the mouse around
9. Release the mouse button when the line/arrow is correctly resized and angled
**Tip:** If you hold down `<Ctrl>` as you resize an object, the centre of the object remains fixed.

## Changing the Colour of an Object

You can set up the colour of a line and infill of an area object by first selecting it and then clicking on the **Shape Outline** or **Shape Fill** button:

1. With the line/arrow still selected, click on the list arrow attached to the **Shape Outline** button
2. Choose the required colour (you can use a Theme colour or Standard colour or can choose your own colour - here choose **More Outline Colors...** and select from the **Standard** palette of 128 colours)

You can even get multi-coloured lines though these are more usually used to fill an area, as you’ll see next:

3. Click on a rectangle or oval to select it
4. Set the line colour as in steps 1 and 2 above (if you don’t want a line at all choose **No Line**)
5. Click on the list arrow attached to the **Shape Fill** button and select a colour from the palette - or choose your own colour using **More Fill Colors...**

As well as a **Solid Colour** you can choose a **Gradient** (in one or more colours), a **Texture** (eg wood or marble) or can even use a picture held in a file. To see these:

6. Repeat step 5 but select **Texture** and choose from one of the standard textures
7. Repeat step 5 again but this time choose **Gradient** and select one of the many variants
8. Repeat step 7 but choose **More Gradients...** - a dialog box appears

![Image of color settings](image.png)

In fact the same box would have appeared had you chosen **More Textures...** at step 6. You can also display it by clicking on the **Shape Styles group arrow**.

9. Click on **Preset colours**, scroll down and choose **Rainbow**, for example
10. Click on **Type**; and change this to **Radial**, for example (note, the **Angle** option only works for **Linear**)
11. Click on **Direction**; and change this to whichever you prefer
12. Click on [Close] and try to make sense of what you have done

You can copy the colour scheme of one object to another by selecting it, clicking on the **Format Painter** button then clicking on the second object. Try this next:

13. **Right click** on the Rainbow object then click on the **Format Painter** button (the little brush) on the local copy of buttons on the **Home** tab
14. Click on one of the other objects to colour it the same
15. Press <Ctrl z> or click on [Undo] to restore the original colour

Changing Text Box Settings

In addition to being able to set a fill and line colour, you can choose the colour you want for text inside a Text Box. In fact you have the full range of formatting available to you - eg font and font size, style, justification, spacing, numbering, highlight, bold/italic etc.

1. Drag though some of the text in one of your text boxes then right click and choose [Bold]
2. For the same text, change the [Font] (eg to Symbol) and [Font Size] (eg to 28)
3. Now press <Ctrl A> (in Word) or <Esc> (in Excel/PP - this selects the whole text box)
4. Click on the [Font Color] list arrow and select a colour for your words, if you want this
5. Click on the [Fill Color] button and select a background colour if you want one
6. Click on the [Line Color] button and select No Outline to hide it
7. Finally, set the required alignment - in PowerPoint, the default is Centred

One other feature of a Text Box is the inner margin between the text itself and the edge of the box. To set this, the Format Text Box window must be displayed:

8. Right click on the text box and select Format Shape...
9. Click on Text Box to see the settings:

   ![Format Text Box Window](image)

10. Set all four Internal Margins to 0 if you want the text right up to the edge
11. Set Autofit to Resize shape to fit text
12. Press <Enter> for [Close] to confirm the changes

Note how the text goes right up to the edge of the box, which has been shrunk to automatically fit it.

Changing Line/Arrow Styles

When you drew a line or arrow, the default line style (thickness etc), dash style (for broken lines) and arrow style (for different arrow points etc) was used. You can set these up before drawing the line/arrow, if you want, or can apply a style to an existing line.

1. Click on the simple line you have already drawn to select it then click on the [Shape Outline] button
2. Choose Weight and make the existing line slightly thicker by selecting 3pt
3. Repeat step 1 but choose Dashes and select one of the styles provided
4. Finally repeat step 1 but choose Arrows

5. Currently, the line doesn’t have an arrow - choose any of the styles to add one to the line

A further selection of line and arrow styles can be obtained via More Arrows… (or More Lines... under Weight or Dashes). Both these open up the Format Shape dialog box. You can also display this by clicking on the Shape Styles group arrow or by right clicking and choosing Format Shape.…

6. Repeat step 1 but choose More Arrows… – the following dialog box appears

7. **Width**: allows you to set your own width – use the arrows to change the width of your line

8. **Compound type**: allows you to choose multiple lines

9. **Dash type**: offers nothing new

10. **Cap type**: lets you choose a rounded end for your line

11. **Join type**: lets you choose rounded objects where two lines meet (eg the corner of a rectangle)

12. The **Arrow settings** let you choose the size and shape of both ends of the line - explore what’s available here and change some of the settings

13. Click on [Close] to confirm the changes

---

**Moving an Object**

To move an object:

1. Move the mouse cursor over the object until the cursor becomes a four-headed cross
2. Hold down the mouse button and drag the object around
3. Release the mouse button when the object is correctly positioned

You can also move objects using the arrow keys:

4. Click on an object to select it (for a text box, click inside then press <Esc>)
5. Press the <arrow keys> to move the object until it is correctly positioned

Note that when one object overlaps another, all or part of one of them may disappear. You will learn later how to change this.

---

**Deleting an Object**

To delete an object:

1. Click on the object to display the handles (for a text box, click inside then press <Esc>)
2. Press the <Delete> or <Backspace> key

You could also remove an object by right clicking and choosing Cut from the pop-up menu.

You can reverse an accidental delete by using the [Undo] button. If you have deleted any of your objects here, restore them with [Undo] (or press <Ctrl z>).

**Understanding the Grid**

A drawing is, by default, done on a grid (like drawing on graph paper). The grid is usually hidden but can be displayed and some people like to draw with the grid showing. This is particularly useful for accurate drawing.

In PowerPoint, the grid is active by default; in Word it is activated when the gridlines are displayed.

1. Use Zoom control in the bottom right corner of the screen and set it to about 300%

To display the grid:

2. On the View tab, turn on [Gridlines] – the gridlines are shown (by dots in PowerPoint)
3. Try moving an object (drag it or use the arrow keys) and note how the handles link to the grid
4. Try resizing an object (or drawing a new one) and note how that is linked to the grid

You can temporarily turn off the grid by using either the <Alt> key (when resizing, drawing or moving) or <Ctrl> key (when moving an object using the arrow keys):

5. Select an object then hold down the <Alt> key and resize it using one of the handles - you will find the size no longer changes in jumps
6. Hold down <Alt> and try moving an object using the mouse - again it moves smoothly
7. Next, hold down <Ctrl> and use the arrow keys to move the object (you’ll find you need to press the key several times to move it by a single grid square)
8. Finally, hold down <Ctrl> and move an object with the mouse – you’ll find you get a copy

**Remember:** When dragging an object, you have to use <Alt> not <Ctrl>.

You can change the spacing of the gridlines and set new default values, if you want.

9. On the Drawing Tools Format tab, click on the [Align] button in the Arrange group and choose Grid Settings... (slightly different dialog boxes appear) - note that you can also turn on View Gridlines here

10. Change the Grid settings if you want to then press <Enter> for [OK]
11. Test out the new grid by repeating some of the steps above
12. Turn off the grid - this time use the [Align] button and View Gridlines
13. Reset Zoom to 100% (or less) so that you can see the whole of the drawing
Aligning and Distributing Objects

One thing you may require is to align and/or evenly space objects. Having snap objects to grid on helps with this as you can see by eye when objects are lined up and correctly spaced. If you aren’t using the grid, however, this task can become very difficult. To help you, commands are provided which do this precisely:

1. Select one of your objects (e.g., an oval) by clicking on it
2. Hold down <Ctrl> and drag the object twice to get three identical objects (or use Copy and Paste)

If you Copy/Paste, the new objects are positioned one grid line apart, both horizontally and vertically.

3. Move the objects so that they are roughly in a line and some distance apart
4. Select all three objects by holding down the <Shift> key and clicking on them – the handles appear

This is the way to select more than one object at a time. You can unselect a particular selected object by clicking on it a second time (while still holding down <Shift>).

5. Now click on [Align] to and select Align Top - the objects are lined up with the top of the highest one
6. Repeat step 5 but this time select Distribute Horizontally - the objects will now all be evenly spaced

Tip: In PowerPoint, you can also select a group of objects by holding down the mouse button and dragging a rectangle to enclose them.

Grouping/Ungrouping Objects

As you gradually build up your drawing, it’s useful to be able to group component parts together. You can then move, resize, colour etc all of the grouped objects at a time.

1. Hold down <Shift> and click on each object in turn (or drag out a rectangle to surround them)
2. With the required objects selected click on [Group] and choose Group

Tip: You can also right click and choose Group.

3. Press the arrow keys to move the group of objects around
4. Resize the group of objects by dragging on one of the corner handles
5. Change the [Shape Outline] and/or [Shape Fill] to colour all the objects the same

The grouped objects act as a single object - you cannot, for example, colour them individually or move one independently. You have to ungroup them before this is possible:

6. Check that the group of objects is still selected then click on [Group] and choose Ungroup

Each object’s handles are now shown, indicating they are separate units.

7. Click away from the group then on one of the objects to select it on its own
8. Press an arrow key to alter its position
9. Change the [Shape Outline] and/or [Shape Fill]
10. Now click on [Group] and select Regroup

You’ll find that Draw remembers which objects were the original members of the group and will regroup them (without you having to select them again individually). Of course, if you wanted to create a different group you could <Shift> select the new set of objects and use a Group command.

When creating a complicated drawing, group the individual objects, as above, then start grouping the groups. The only problem with this occurs when you need to edit an object at the lowest level – you then have to progressively ungroup until you reach that level and then regroup until all the drawing is grouped together again.
Changing Object Order

Another feature you will probably have noticed, particularly with areas, is that one object may wholly or partially hide another. To overcome this you have to reset the display order of the objects. The default order is that the newest object is placed on top of all the others. To demonstrate this and change the order:

1. Click on [Rectangle] and draw a large rectangle over all or most of your current objects - you will find that they are hidden
2. Now click on the [Send to Back] button in the Arrange group and choose Send Backward - one of the hidden objects should reappear

Note that Word offers two additional options here, Bring in Front of Text and Send Behind Text.

3. Repeat step 2 to reveal further objects
4. Repeat step 3 but this time choose Send to Back - all the objects should now be visible

Tip: You can also right click and choose Send to Back.

You have seen how an individual object can be moved up/down the stack of objects either one item at a time or to the very top/bottom. An alternative strategy is to make the object transparent:

5. Click on the [Bring to Front] button and choose Bring to Front - the objects are hidden again
6. Right click on the rectangle and choose Format Shape
7. In the Fill settings, use the Transparency: slider and watch what happens (if this is set to 0% the colour is solid, if it’s 100% then it’s equivalent to No Fill)
8. Set to Transparency: about 70% then click on [Close]
9. Drag the rectangle around and watch how different objects are hidden or shown in full
10. End by removing the rectangle completely - press <Delete> or <Backspace>

Rotating an Object

Another command allows you to rotate an object, or make it a mirror image.

1. Click on the arrow to select it - if necessary, move it or use [Bring to Front] to see it properly
2. Click on the [Rotate] button and drag the mouse through the fixed settings – as you do, the arrow moves to reflect the highlighted option
3. Also try More Rotation Options … - a Size and Position dialog box appears (you can also display this by right clicking on the object and choosing Size and Position)
4. Drag the dialog box so that it doesn’t obscure the arrow then change the Rotation: using the spin control on the right – again, the arrow moves as the settings are changed
5. Try changing the Height and Width too and watch what happens
6. Click on [Close] when the arrow is positioned and sized as required

Flipping and rotating can be applied to any sort of object. In Word, you can’t rotate or flip the text in a text box (in PowerPoint you can) but you can change the [Text Direction]. The same applies to free rotation:

7. Click on any solid shape (including the text box) to select it
8. Point the mouse cursor to the small green circle which appears (the cursor becomes a circular arrow) then hold down the mouse button and drag the mouse around to rotate the object

Lines and arrows don’t have this free rotate handle but they can still be rotated as you saw with the arrow at the start of this section.

Tip: You can select several objects and rotate them all at the same time.
Other Shapes

As well as the basic shapes you have already seen, Draw provides a host of more complex shapes including geometric and other basic shapes, stars, callouts, flowchart objects, fancy arrows and curved lines (plus connectors). The Line shapes are the most important and are dealt with later. As an example of creating and modifying one of the other shapes, try drawing a block arrow:

1. Click on the [Right Arrow] button in the middle of the [Shapes] in the Insert Shapes group
2. Position the mouse cursor where you would like the arrow to start then hold down the mouse button and move the mouse (as if you were drawing a rectangle)
3. Release the mouse button when the arrow is the required size

Because this is a slightly more complicated shape, additional handles are provided. The yellow diamonds are used to control the width of the arrow shaft and size of the arrow head.

4. Position the mouse cursor over the yellow handle on the left, hold down the mouse button and drag the mouse up or down - release the mouse button when the shaft is the correct thickness
5. Repeat step 4 but use the other yellow handle and move the mouse left or right to set the size of the arrow head
6. Use the normal handles to change the overall size and shape of the arrow
7. You can colour the arrow (the fill and the line) as before, if you want

Next try an even more complicated shape - a curved arrow. This isn’t one of the shapes currently showing, so:

8. Click on the [More] arrow below the scroll bar on the right of the [Shapes] to display all the shapes
9. In the Block Arrows group, select [Curved Right Arrow] - left column, second row
10. Draw the arrow in the position required as described in steps 2 and 3

When you release the mouse button you will find three additional yellow handles are provided to manipulate the shape. The one on the right controls the height of the arrow head, the one at the bottom the head’s width, while the third determines the width of the shaft.

11. Repeat step 6 on all three yellow handles to see exactly what they control
12. Colour the arrow and rotate it using the green circle, if you like

You can try out some of the other Shapes, if you like. Watch out for the yellow handles and try moving them to see the effect - for example, you can alter the smile on the Smiley Face under Basic Shapes or the spikiness of a Point Star under Stars and Banners.

Drawing an Irregular Shape

One of the shapes provided under Lines is called Freeform. This allows you to draw an irregular shape (such as a house - a rectangle plus trapezoid).

1. If using PowerPoint, press <Ctrl m> to insert a new slide - in Word Scroll down the display to draw in a clear area
2. On the Insert tab of the Ribbon click on [Shapes] and choose [Freeform] –the last but one in the Lines group
3. Move the mouse cursor to where you want to start your object and click the mouse button
4. Move the mouse and you will find an elastic line attached
5. Click the mouse button to fix the line
6. Move the mouse again and a new elastic line appears - again, click to fix the line
7. Repeat step 6 until you complete your shape (back to the point where you started the object)
Handles now appear round the object and the elastic line disappears. Note that you can draw multiple lines to and from points (other than the starting position) in your object - only when you click on the start point does the drawing end.

**Tip:** To draw an open object (i.e. where you don’t want to end at the start point), *double click* on the mouse when you draw the final line.

Sometimes you don’t want a straight line between two points. To draw a line freehand you simply hold down the mouse button rather than click on it. This is equivalent to the [Scribble] button, which is another option available under the heading **Lines**.

8. Click on *Freeform* to start off your freeform shape – this now shows on the *Drawing Tools Format* tab
9. Draw a straight line then hold down the mouse button after you fix the end of the line
10. The cursor now turns into a pencil - as you move the mouse, a freehand line appears
11. Release the mouse button to end the freehand drawing
12. Continue drawing the shape, either clicking to draw straight lines or holding down the mouse button to draw freehand
13. Complete the shape by returning to its origin (or by *double clicking* the mouse)

**Editing an Irregular Shape**

It takes quite a lot of practice to be able to draw freehand with the mouse. Even for those with poor mouse control all is not lost, however, as you can always edit the shape to correct any mistakes:

1. With the freeform shape you have just drawn still selected, click on the *[Edit Shape]* button in the *Insert Shapes* group and choose **Edit Points**

A series of points (called *vertexes*) now appears, some marking the end of the straight lines while others are scattered along the freehand line. Draw fits a smoothed curve to these points, which define the line. You are now free to move (or delete) any of these points to improve your drawing.

2. Position the mouse cursor over any of the points - it changes from a four-headed cross to a small square with four tiny arrow heads
3. Hold down the mouse button and drag the point to where you want it
4. Use the *[Zoom]* slider to help by showing finer detail
5. Repeat steps 2 and 3 to position a point exactly
6. To delete a point, *right click* on it and from the shortcut menu choose **Delete Point**
7. To add an extra point, *right click* on the line where you want it placed and choose **Add Point**
8. To help smooth a line, *right click* on a line and try **Straight Segment**

The other options here give you full control over smoothing - with, **Smooth Point** you are provided with extra handles. These allow you to control the shape of the line in that area precisely.

9. End by resetting *[Zoom]* to its original level

**Drawing a Curve**

The other type of line you can draw is a curve. A simple curve is defined by three anchor points; further points define a polynomial.

1. Click on the *[More]* arrow attached to *[Shapes]* then, in the *Lines* group click on *[Curve]* - to the left of *[Freeform]*
2. Position the cursor where you would like the curve to begin then click the mouse button
3. Move the cursor to roughly the mid-point of the curve and click the mouse button again
4. Finally, move the cursor to where you want the curve to end (an elastic curved line is displayed) and *double click* on the mouse button to complete the curve.

You can now edit the curve to get the precise shape you require:

5. Click on the [Edit Shape] button and choose **Edit Points**

6. Move the mouse pointer over the middle vertex, hold down the mouse button and drag the point to alter the shape of the curve

7. Repeat step 6 on an end vertex to stretch out or alter the end position

8. Click away from the curve to switch off the edit points

To draw a polynomial:

9. Repeat steps 1 to 3 as above

10. Keep clicking on the mouse button to set further points along the curve

11. *Double click* on the mouse or close the curve (by clicking at the start point) to end drawing

### Shape Effects

Another whole group of drawing tools can be found via the [Shape Effects] button on the Drawing Tools Format tab. These include Shadows, Reflection, Glow, Soft Edges, Bevel and 3-D Rotation. Some of these options can also be accessed via the Format Object dialog box seen earlier.

1. Draw a new [Rectangle] in the bottom left corner of the current slide (or screen area)
2. Click on the [Shape Effects] button in the Shape Styles group
3. Choose **Presets** and move the mouse between those provided – watch how the shape changes
4. Repeat steps 2 and 3 but investigate the settings under the other headings

You have further control over shadows and 3-D effects, as you’ll see in the following sections. Note that the controls for these options are provided differently in Microsoft Word.

### Adding Shadows

To add a shadow to an object (or change a preset one):

1. Select the object then click on the [Shape Effects] button and choose **Shadow** followed by **Shadow Options**... - the Format Shape dialog box appears showing the **Shadow** settings

2. Choose any of the **Presets** to activate the other settings

3. Amend the current settings, as required

4. When you have finished adding a shadow to the object, **[Close]** the Format Shape dialog box
3-D Effects

To customise a 3-D Effect:

1. Select the object then click on [Shape Effects] and choose Preset and choose one of the 3-D settings

2. Click on [Shape Effects] and choose Preset again but this time choose 3-D Options… - the Format Shape dialog box appears showing all the 3-D Format settings

3. Try altering some of the settings to see what happens – eg increase the Depth: significantly and, under the Surface heading select different Material: and Lighting: settings

Next, look at the 3-D Rotation settings:

4. Click on 3-D Rotation on the left of the Format Shape dialog box – another set of options appears (you can also see this from [Shape Effects] then 3-D Rotation and 3-D Rotation Options…):

5. Use the spin buttons on the right of the Rotation settings and watch what happens

6. Click on [Reset] if you want to return the object to its original settings

7. [Close] the Format Shape dialog box when you’ve seen enough
WordArt

Another feature available to you in Microsoft Office is WordArt. This lets you type in text in a wide variety of layouts such as in a curve, using outlined letters or with a shadow. To see what's available:

1. Start by moving to a clean area (in PowerPoint, press <Ctrl m> for a new slide)
2. On the Insert tab, click on [WordArt] and choose anything from the selection provided
3. In the box which appears, type in some text (eg your name)
4. Move the box into the bottom left corner of the screen, so that you can see what happens as you select the different WordArt Styles
5. Click on the [More] down arrow on the right of the [Styles] in the WordArt Styles group
6. Move the mouse over the different styles to see their effect

The three buttons on the right of this section determine the text fill, text outline and text effects:

7. Click on the [Text Effects] button and explore the Shadow, Reflection, Glow, Bevel and 3-D Rotation settings – these are similar to those seen earlier in [Shape Effects]
8. Next, click on [Text Effects] and choose Transform – your text can now appear in a curve or whole host of other shapes – watch what happens as you move the mouse cursor over them
9. End by selecting some of the Text Effect settings you have explored in steps 7 and 8

The WordArt provided in Microsoft Word works slightly differently. Here, you have a WordArt Gallery and other settings to change the text spacing, height etc. If you need these facilities you can always create your WordArt in Word and then Copy and Paste it into PowerPoint.

This brief introduction to WordArt should have made you aware of some of the features available. It's particularly useful for poster design.

The Drawing Canvas

By default, the drawing tools draw over the top of existing text and diagrams. In Microsoft Word, however, you can compose a drawing in a separate region, known as the Drawing Canvas. To do this (in Word):

1. Before you start your drawing, move to the Insert tab, click on [Shapes] and choose New Drawing Canvas - an area appears in which you make your drawing
2. Increase the size of the canvas, if necessary, by dragging on the side/corner handles
3. When you have completed your drawing, again drag in the handles to cut off any blank areas
4. To resize the canvas, right click and choose Scale Drawing - the normal corner handles appear which you can use to enlarge (or shrink) the whole drawing (as opposed to extend the canvas)

You can also set up Word so that a drawing canvas is always used (though it’s not recommended):

1. For Word only, click on the [Office Button] and choose [Word Options]
2. Move to the Advanced tab and under Editing options at the top, turn on Automatically create drawing canvas when inserting AutoShapes
3. Press <Enter> for [OK]

™ Trademark owned by Microsoft Corporation.
© Screen shot(s) reprinted by permission from Microsoft Corporation.
Copyright © 2008: The University of Reading
Last Revised: August 2010